
 

Users’ Guide to Using the 
Photo Series Explorer and Photo Manager 

Programs 
 

                                    
Browse Mode Query Mode 

  
Compare Photos Build Fuel Profiles 

  
 

  03/07/2016  



Users’ Guide to PSExplorer, Version 3 PSE - Page 2



Users’ Guide to PSExplorer, Version 3 PSE - Page i

Table of Contents 
 
Welcome to PSExplorer...................................................................................................................1 
 
Photo Series .....................................................................................................................................1 

Photo Series Images......................................................................................................................3 
Activity Types............................................................................................................................3 
Vegetation Types .......................................................................................................................4 
Fuel Models ...............................................................................................................................5 

Photo Series Books .......................................................................................................................5 
Fuel Types and Fuel Size Classes.................................................................................................7 

 
The PSExplorer Screen Format and Definitions..............................................................................7 
 
PSExplorer Main Menu and Toolbar Icon Descriptions 

File Main Menu...........................................................................................................................10 
Printer Setup.............................................................................................................................10 
Manage Photo Series Book......................................................................................................10 

Activating a Photo Series Book ............................................................................................11 
Deactivating a Photo Series Book.........................................................................................11 
Setting the PhotoImages Directory .......................................................................................12 

Exit...........................................................................................................................................13 
View Main Menu ........................................................................................................................13 
Tools Main Menu........................................................................................................................14 

Query Mode .............................................................................................................................14 
Compare Photo Series Mode ...................................................................................................17 

PSExplorer Assistant, Comparison Assistant Tab ................................................................18 
Fuel Profile Builder Mode .......................................................................................................19 

PSExplorer Assistant, Profile Builder Assistant Tab............................................................19 
Reports Main Menu ....................................................................................................................20 
Help Main Menu.........................................................................................................................20 

 
The Query Tabs..............................................................................................................................21 
 
Searching for Photos ......................................................................................................................23 

Query by Photo Series Book.......................................................................................................23 
Query for Total Dead Down Woody Fuel Loading Using Vegetation Type, 
   Activity Type, and Dead Down Woody Total Fuel Loading...................................................24 
Query for Total Dead Down Woody Fuel Loading Using Vegetation Type, 
   Activity Type, 03” and 3.1”+ Dead Down Woody Total Fuel Loading..................................25 
Query for Live Fuel Loading Using Vegetation Type, Activity Type, Herbaceous 
   and Shrub Fuel Loading...........................................................................................................25 
Query by Fire Behavior (FBPS) or Danger Rating (NFDRS) Fuel Model.................................26 

 
Using Local Photo Series 

Photo Series Attributes ...............................................................................................................27 
Electronic Graphics Files for Photos and Data Plates ................................................................27 
Using Photo Manager to Enter Local Photo Series Attributes into the Photos Database...........29 

 
Bibliography of References ..........................................................................................................35 



Users’ Guide to PSExplorer, Version 3 PSE - Page ii

 

ICON Descriptions Summary 

 Toggle Screen View/Query Mode  

 Toggle Photo Series Compare Mode 

 Toggle Fuel Profile Builder Mode 

 Toggle PSExplorer Assistant 

 Reset Available Photos To All Active Photo Series 

 Reset All Query Parameters To The Defaults 

 Toggle Icon View  

 Toggle List View 

 Exit 

 Help 

 

Contacting Us 
We enjoy hearing from the users of FMAPlus.    
 
Fire Program Solutions, LLC 
17067 Hood Court 
Sandy, Oregon 97055 
Email: dcarlton1@aol.com  
Phone: (503) 668-1390 
FAX: (503) 668-1392 
Web Site: www.fireps.com 
 

Technical Support     Email Support 
Fuels Management Analyst Support Page   dcarlton1@aol.com 
http://www.fireps.com/fmanalyst3/  
 

FMA®, FMAPlus®, DDWoodyPC®, PSExplorer® and CrownMass® are all registered trademarks 
of Fire Program Solutions LLC and Acacia Services. 
 
© Fire Program Solutions, LLC/Acacia Services, 1999-2016 
 
“No portion of this publication may be reproduced, stored in a retrieval system or transmitted in 
any form, or by any means electronic, mechanical, photocopied, recorded or otherwise, without 
the prior written permission of Fire Program Solutions, LLC or Acacia Services.” 
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Welcome to PSExplorer! 
The PSExplorer program within Fuels 
Management Analyst facilitates: 
 

 The viewing of published and 
locally generated Photo Series 

 
 The searching of published and 

locally generated Photo Series for 
photos that meet defined criteria 

 
Searching for photos based on defined criteria is done via database queries.  Four types of 
queries are available: 
 

 Query by Photo Series Book 
 Query for Total Dead Down Woody Fuel Loading Using Vegetation Type, Activity Type 

and Dead Down Woody Total Fuel Loading 
 Query for Total Dead Down Woody Fuel Loading Using Vegetation Type, Activity 

Type, 0-3” and 3.1”+Dead Down Fuel Loading 
 Query for Live Fuel Loading Using Vegetation Type, Activity Type, Herbaceous and 

Shrub Fuel Loading 
 Query by Fire Behavior (FBPS) or Danger Rating (NFDRS) Fuel Model 

 

Photo Series 
Managers frequently need to define fuel profile objectives to support land management planning 
project objectives.  The definition of these fuel profiles is often done using photos from 
published and/or locally generated photo series.  The DDWoodyPC and PSExplorer programs 
within the FMAPlus have access to all photos and data plates from the following photo series: 
 
GTR-INT-46    Photo Series for Appraising Thinning Slash in Northern Idaho; Western 

Hemlock, Grand Fir and Western Redcedar Timber Types 
 
GTR-INT-96  Photo Guide for Appraising Downed Woody Fuels in Montana Forests: 

Grand Fir/Larch/Douglas-fir, Western Hemlock, Western Hemlock/Western 
Redcedar and Western Redcedar Cover Types  

 
GTR-INT-97  Photo Guide for Appraising Downed Woody Fuels in Montana Forests: 

Interior Ponderosa Pine. Ponderosa Pine/Larch/Douglas-fir, Larch/Douglas-
fir and Interior Douglas-fir Cover Types 

 
GTR-INT-98  Photo Guide for Appraising Downed Woody Fuels in Montana Forests: 

Lodgepole Pine and Englemann Spruce-Subalpine Fir Cover Types 
 
GTR-NA-FR-22 Photo Series for Quantifying Forest Residues in the: Northern Hardwood and 

Oak-Hickory Types 
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GTR-NA-FR-25 Photo Series for Quantifying Forest Residues in: Loblolly Pine, Eastern 

White Pine, Pitch Pine and Virginia Pine 
 
GTR-PNW-51  Photo Series for Quantifying Forest Residues in the: Coastal Douglas-fir-

Hemlock and Coastal Douglas-fir Hardwood Types 
 
GTR-PNW-52  Photo Series for Quantifying Forest Residues in the: Ponderosa Pine, 

Ponderosa Pine and Associated Species and Lodgepole Pine Types 
 
GTR-PNW-95  Photo Series For Quantifying Forest Residues in Sierra Mixed Conifer and 

Sierra True Fir Types 
 
GTR-PNW-105 Photo Series for Quantifying Natural Forest Residues in Common Vegetation 

Types of the Pacific Northwest 
 
GTR-PSW-56  Photo Series for Quantifying Natural Forest Residues: Southern Cascades 

and Northern Sierra Nevada 
 
PMS 830   Stereo Photo Series for Quantifying Natural Fuels.  Volume I: Mixed-conifer 

with Mortality, Western Juniper, Sagebrush and Grassland Types in the 
Interior Northwest. 

 
PMS 831   Stereo Photo Series for Quantifying Natural Fuels.  Volume II: Black Spruce 

and White Spruce Types in Alaska. 
 
PMS 836   Stereo Photo Series for Quantifying Natural Fuels.  Volume IIa: Hardwoods 

with Spruce in Alaska. 
 
PMS 832   Stereo Photo Series for Quantifying Natural Fuels.  Volume III: Lodgepole 

Pine, Quaking Aspen and Gambel Oak Types in the Rocky Mountains. 
 
PMS 833   Stereo Photo Series for Quantifying Natural Fuels.  Volume IV: Pinyon-

Juniper, Chaparral and Sagebrush Types in the Southwestern United States. 
 
PMS 834   Stereo Photo Series for Quantifying Natural Fuels.  Volume V: Midwest Red 

and White Pine, Northern Tallgrass Prairie and Mixed Oak Types in the 
Central and Lake States. 

 
PMS 837   Stereo Photo Series for Quantifying Natural Fuels.  Volume Va: Jack Pine in 

the Lake States. 
 
PMS 835   Stereo Photo Series for Quantifying Natural Fuels.  Volume VI: Longleaf 

Pine, Pocosin and Marshgrass Types in the Southeastern United States. 
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PMS 838   Stereo Photo Series for Quantifying Natural Fuels.  Volume VIa: Sand Hill, 
Sand Pine Scrub and Hardwoods with White Pine Types in the Southeastern 
United States with Supplement Sites for Volume VI (2003). 

 
Black Hills  Photo Series for Quantifying Forest Residues in the Southwestern Region: 

Black Hills Photo Series A-89-6-82 
 
Photo Series Images 
For each photo series photo, there are two graphic images available for use.  One image is of the 
photo and the other is of the data plate.  The data plate contains the attributes of the photo such 
as fuel loadings and stand measurements. 
 

Example Photo Image Example Data Plate Image 

 
To facilitate queries, each photo has been assigned to an Activity Type, a Vegetation Type and a 
Fuel Model. 
 
Activity Types 
There are five activity types as follows: 
 

 Natural (Nat) 
 Clearcut (CC) 
 Partial Cut (PC) 
 Thinning (TH) 
 Regeneration Cut (RC) 
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Vegetation Types  
There are 42 vegetation types as follows: 
 

Code Veg. Type Code Veg. Type 
BR Brush PP Ponderosa Pine 
BS Black Spruce PPAS Ponderosa Pine/Associated Species 

DFHD Douglas-fir - Hardwood PPLDF Ponderosa pine, Larch, Douglas-fir 
DFI Douglas-fir - Interior QA Quaking Aspen 

DFWH Douglas-fir, Western Hemlock RF Red Fir 
GF Grand fir, Larch, Douglas-fir RWP Red and White Pine 
GO Gamble Oak SA Subalpine fir 
GR Grass SB Sagebrush 
HD Hardwood SFES Subalpine Fir, Englemann Spruce 
JP Jack Pine SH Shrub 
JU Juniper SHP Sandhill Pine 

LDF Larch, Douglas-fir SPHD Spruce Hardwoods 
LL Loblolly Pine TF True fir 

LLP Longleaf Pine VP Virginia Pine 
LP Lodgepole Pine WC Western Red Cedar, Western Hemlock 
MC Mixed Conifer WF White Fir 
MF Mixed Conifer, Fir WH Western Hemlock 
MH Mountain Hemlock WJ Western Juniper 
MP Mixed Conifer, Ponderosa Pine WP White Pine (Eastern) 

NHOH Northern Hardwood, Oak Hickory WPHD Hardwoods with White Pine 
PiP Pitch Pine WS White Spruce 
PO Pocosin   

 
The vegetation types were assigned based on how the photos were aggregated in the published 
photo series.  This provides for the possible inclusion of a tree species in more than one 
vegetation type.  For example, photos with the tree species Ponderosa pine might occur in the 
following vegetation types: MC, MP, PP, PPAS and PPLDF. 
 
The Activity Type and the Vegetation Type are used is the following queries: 
 

 Query for Total Dead Down Woody Fuel Loading Using Vegetation Type, Activity Type 
and Dead Down Woody Total Fuel Loading 

 

 Query for Total Dead Down Woody Fuel Loading Using Vegetation Type, Activity 
Type, 0-3” and 3.1”+Dead Down Fuel Loading 

 
 Query for Live Fuel Loading Using Vegetation Type, Activity Type, Herbaceous and 

Shrub Fuel Loading 
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Fuel Models 
A surface fuel model has been assigned to each photo using on the Fire Behavior Prediction 
System (FBPS) and National Fire Danger Rating System Fuel Models.  The 13 1982 FBPS and 
the 20 NFDRS fuel models are listed below. 
 

 
A team of Fire Behavior Analysts reviewed 
each photo and assigned a Fire Behavior 
and Danger Rating fuel model to each 
photo.  Each Analyst considered “what fuel 
strata would be the primary carrier of the 
fire.”  This can vary with changes in weather and topographic conditions.  Since there are only 
13 1982 FBPS and 20 NFDRS fuel models to select from, a difficult decision in fuel model 
assignment occasionally occurred. Remain aware that differences in fuel model assignment 
decisions based on the interpretation of conditions depicted in a photo are expected.   Using a 
highly experienced team of Fire Behavior Analysts to make the fuel model assignments, the 
developers of FMAPlus have attempted to minimize interpretation differences. 
 
Photo Series Books 
The phrase “photo series book” is used within FMAPlus 3 to define an aggregation of photos 
from one of the published photo series.  The entire published photo series can be defined as a 
photo series book or a subset of photos from a published photo series can be aggregated into a 
photo series book.  In the second scenario, a published photo series would be represented in 
FMAPlus 3 as more than one photo series books.  The table on the next page lists the photo 
series books in release 3.0.X of FMAPlus 3.  As additional photo series are published, they may 
be added to future releases of FMAPlus.  The table on the next page summarizes the Photo Series 
Books in FMAPlus 3.0.X. 
 

Fuel 
Group 

1982 FBPS Fuel Model 
Number and Description 

1 - Short Grass (1 foot) 
2 – Timber with grass 
       and understory 

Grass 

3 - Tall Grass (2.5 feet) 
4 – Chaparral 
5 – Brush 
6 - Dormant Brush 

Brush 

7 - Southern Rough 
8 - Closed Timber Litter 
9 - Hardwood / Pine 
      long needle litter 

Timber 
Litter 

10 - Timber 
11 - Light Slash 
12 - Medium Slash Slash 
13 - Heavy Slash 

Fuel 
Group 

NFDRS Fuel Model Number 
and Description 

A – Western Annual Grasses 
C – Open Pine with Grass 
L – Western Perennial Grasses 
N – Sawgrass 
S – Tundra 

Grass 

T – Sage with Grass 
B – Mature Brush (6 feet) 
D – Southern Rough 
F – Intermediate Brush 
O – High Pocosin 

Brush 

Q – Alaska Black Spruce 
E – Hardwood Litter (Fall) 
G – Heavy Short Needle Timber Litter 
H – Normal Short Needle Timber Litter 
P – Southern Lone Needle Pine Litter 
R – Hardwood Litter – Spring/Summer 

Timber 
Litter 

U – Western Long Needle Litter 
I – Heavy Slash 
J – Medium Slash Slash 
K – Light Slash 
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Photo Series 

Book 
Published 

Photo Series
Activity 
Types 

Vegetation 
Types 

AK-Black Spruce PMS 831 Nat BS 

AK-Hardwoods/Spruce PMS 836 Nat SPHD 

AK-White Spruce PMS 831 Nat WS 

Black Hills SW Region Nat, PC TH PP, PPAS 

Demo Assorted Nat PP, PPAS 

INT-46 GTR-INT-46 TH GF, WC, WH 

INT-96 GTR-INT-96 Nat GF, WC 

INT-97 GTR-INT-97 CC, Nat, PC TH DFI, LDF, PP, PPLDF 

INT-98 GTR-INT-98 Nat MC, SFES 

Jack Pine PMS 837 Nat JP 

Mixed Oak Types-Spring PMS-834 Nat NHOH 

Mixed Oak Types-Summer PMS-834 Nat NHOH 

NAFR-22 NA-FR-22 CC, Nat NHOH 

NAFR-25 NA-FR-25 CC, Nat, PC TH LL, NHOH, VP 

PNW-105 GTR-PNW-105 Nat 
BR, DFHD, DFWH, GR, JU,LP, MC, 
PP, PPAS, SA 

PNW-51 GTR-PNW-51 CC, PC, TH DFHD, DFWH 

PNW-52 GTR-PNW-52 CC, PC, TH LP, PP 

PNW-95 GTR-PNW-95 RC MC, TF 

PNW-Interior-Grass PMS 830 Nat GR 

PNW-Interior-MC with Mortality PMS 830 Nat MC 

PNW-Interior-Sagebrush PMS 830 Nat SB 

PNW-Interior-Western-Juniper PMS 830 Nat JU 

PSW-56 GTR-PSE-56 Nat LP, MH, MP, PP, RF, WF 

Red & White Pine-Spring PMS-834 Nat RWP 

Red& White Pine-Summer PMS-834 Nat RWP 

RM-Gamble Oak PMS 832 Nat GO 

RM-Lodgepole PMS 832 Nat LP 

RM-Quaking Aspen PMS 832 Nat QA 

SE-Hardwoods/White Pine PMS 838 Nat WPHD 

SE-Longleaf Pine PMS 835 Nat LLP 

SE-Marshgrass PMS 835 Nat GR 

SE-Pocosin-Shrub PMS 835 Nat PO 

SE-Pocosin-Woodland PMS 835 Nat PO 

SE-Sandhill Pine PMS 838 Nat SHP 

SW-Chaparrel PMS 833 Nat SH 

SW-Pinyon-Juniper PMS 833 Nat JU 

SW-Sagebrush PMS 833 Nat SB 

Tallgrass Prairie-Spring PMS-834 Nat GR 

Tallgrass Prairie-Summer PMS-834 Nat GR 
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Fuel Types and Fuel Load Size Classes 
Fuels are typed as dead or live.  Furthermore, live 
fuels are divided into a herbaceous and shrub 
categories. 
 
The fuel weight of dead downed woody material is 
frequently stratified into the following categories:  
 

 Foliage 
 0.0” to 0.25” 
 0.26” to 1.0” 
 1.1” to 3.0” 
 3.1”+ 

  
The 3.1”+ dead material is usually subdivided into 3 
to 4 subcategories that do vary by photo series. 
  

The PSExplorer Screen Format and Definitions 
 
The screen viewed upon initial startup of PSExplorer follows.  The screen is composed of the 
following sections: 
 
The Main Menu 
and Toolbar Icons   
 

The Query Tabs 
 

The Selected Photo 
Series Browse 
Window 
 
 
The Photo/Data  
Display Window 
 
 
 

 
The Program 
Status Bar 
 
The main menus and icons on the toolbar are used to implement program processes.  The query 
tabs support the display of photos that meet specific query criteria.   
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The browse window displays the current universe of selected photos in either the List View or in 
Icon View.  In the List view, each attribute of a photo is shown in columnar format.  
 

 
 
The 13 columns are: 
 

 Book/Photo ID 
 Photo Description 
 0.0” – 3.0” Dead Down Woody (DDW) Fuel Loading (Tons/Acre) 
 3.1”+ Dead Down Woody (DDW) Fuel Loading (Tons/Acre) 
 Total Dead Down Woody (DDW) Fuel Loading (Tons/Acre) 
 Herbaceous Fuel Loading (Tons/Acre) 
 Shrub Fuel Loading (Tons/Acre) 
 Duff Depth (inches) 
 Fuel Bed Depth (inches) 
 Vegetation Type 
 Activity Type 
 1982 FBPS (FB) Fuel Model 
 NFDRS (DR) Fuel Model 

 
Note that not all columns may be shown requiring a need to scroll to the right to see hidden 
columns. 
 

Hot Tip 

 

 
If the user clicks on the column label, the photos are sorted either numerically 

or alphabetically based on the information in the columns.  The sort will be 
either in increasing order or decreasing order.  By clicking a second time 

on the column label, the sort will change order. 
 

 
If the user wishes have a better view of the photos identifiers in the universe of selected photos, 
then the user should select the Icon View. 
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The photo/data display window supports the display of a specific photo and the specific data that 
is contained in the 13 attributes recorded in the photos database in FMAPlus. 
 

 
 
The program status bar shows the number of photos currently active for viewing as well an 
identifier of the currently displayed photo. 
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PSExplorer Main Menu and Toolbar Icon Descriptions 
The PSE main menu and toolbar are shown in the 
figure at the right.  Below is a description of each 
main menu item and the tool bar icons. 
 
 
The File Menu 
This main menu item allows the user to perform a Printer Setup, 
Manage Photo Series and Exit the program. 
 
 
Printer Setup 
Selecting the Printer Setup option will display the Print Setup dialog box relative to the default 
printer defined for your computer. 
 
Manage Photo Series 
For currently supported photo series, this menu item is used to Activate a Photo Series Book or 
to Deactivate a Photo Series Book. These actions are supported using the Photo Manager 
program.  The Photo Manager program can also be used to make non-supported and local photo 
series available for use in the DDWoodyPC and PSExplorer programs (see Using Local Photo 
Series).  The Photo Manager program can be started externally from the PSExplorer program by 
selecting the Start=>Programs=>FMAPlus 3 menu.   If the File=>Manage Photo Series menu 
is selected within the PSExplorer program, the screen below will appear. 
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Activating a Photo Series Book 
Before photos can be viewed or data used in PSExplorer, the user needs to designate which 
photo series will be identified for use.  This process is called Activating Photo Series Books.  
Designating a photo series book as active makes that photo series book available to the user 
using the PSExplorer program.  Initially on program installation, only the Demo photo series 
book is designated as active. 
 
To activate a photo series, click in the box in the Active column to the left of the photo series.  
When the box is first clicked, a check will appear and a pencil symbol will appear to the left of 
the box.  Press the down arrow key on the keyboard.  Notice the pencil symbol will disappear 
and there will be a right arrow just below where the pencil symbol was.  This action records the 
activation of the photo series INT-96 to the photo3.mdb. The screen below shows photo series 
INT-96 and Demo active.   

 
The user can activate all of the photo series at one time by clicking on the Activate All button. 
 
Deactivate a Photo Series Book 
If the user wishes to deactivate a photo series, click in the box in the Active column to the left of 
the photo series.  When the box is first clicked, the check will disappear and a pencil symbol will 
appear to the left of the box.  Press the down arrow key on the keyboard.  Notice the pencil 
symbol will disappear and there will be a right arrow just below where the pencil symbol was.  
This action records the deactivation of the selected photo series in the photo3.mdb. 
 
The user can deactivate all of the photo series at one time by clicking on the Deactivate All 
button. 
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Setting the Photo Images Directory   
All of the photo images distributed with FMAPlus are installed to the PhotoImages folder in the 
folder where FMAPlus 3 was installed. The path to the PhotoImages folder is set during the 
program installation. 
 
In this step, the user will verify that the path to the PhotoImages folder is correctly set.  If it is 
not, the process to correctly set the path will be described.  To check the path currently set to the 
PhotoImages folder, start the Photo Manager program by clicking on: 
 
            Start =>Programs=>FMAPlus 3=>Photo Manager  
 
In the upper left part of the Photo 
Manager program screen, the Photo 
Images Location is displayed (see 
right). The default path is c:\Program Files\FMAPlus 3\PhotoImages\.  
 
If the path is not correctly set to the folder where 
FMAPlus 3 is installed, click on the Set Location to 
Retrieve Images button located in the upper right 
corner of the screen.   
 
 
 
A dialog will appear with the top part appearing as 
in the figure to the right..  Click on the radio button 
at the top titled 1. Retrieve images from a hard 
drive.  Select the hard drive letter from the 
pulldown just below this title.   
 
Navigate to the file location where the PhotoImages 
folder resides. The default installation location is: 
 
       C:\Program Files\FMAPlus 
 
In this folder, a PhotoImages subfolder has been 
created upon program installation. Select this folder 
by double clicking on it or the PhotoImages folder 
that you have created at a different location.  If the 
default folder location is selected, the dialog will 
appear as shown in the figure at the right.  Click on 
the OK button and the dialog will close.  Check the 
top of the dialog to verify the path to the PhotoImages is defined correctly.  Exit the Photo 
Manager program by clicking on the Exit button. 
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Exit 
The menu item will support the quitting of the program.  The toolbar icon        performs the same 
action the File=> Exit menu.  
 
The View Menu 
This main menu item allows the user to change the view in the The 
Selected Photo Series Browse Window between a List View and an 
Icon View.   
 
 
List View 
The List View appears as follows: 
 

 
 

The user can also select the List View by clicking on the  icon from the Toolbar. 
 
Icon View 
The Icon View appears as follows: 

 

The user can also select the Icon View by clicking on the  icon from the Toolbar. 
 
Display All Photos 
Selecting this menu item will reset the query database to contain all of the photo series that are 
active. 

The user can also implement the Display All Photos menu function by clicking on the  icon 
from the Toolbar. 
 
At the bottom of the screen is the Windows Status Bar.  It displays the number of photos 
currently within the universe of active photos. 
 

 
 
Reset Query Parameters 
Selecting this menu item will reset the query parameters to the default settings. 

The user can also implement the Reset Query Parameters menu function by clicking on the  
icon from the Toolbar. 
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The Tools Menu 
PSExplorer has two Screen Modes, Browse and Query as well as two 
Tools that can be used to Compare photos or Build a Fuels Profile.  The 
user can select the Screen and Tool Modes from the Tools menu item 
on the Main Menu or by clicking on the icon on the Toolbar as noted.   
 
Query Mode 
Selecting this menu item will cause the Query Tab to appear. 
 

 
 

The user can also implement the Tools=>Query menu function by clicking on the  icon from 
the Toolbar. 
 
By implementing this menu function, the user can switch between the Browse Photo screen 
mode and the Query Photos screen mode.  
 

Browse Mode Query Mode 

  
 
 

Hot Tip 

 

 
If the user places the cursor over the line between the Selected Photo Series 

Browse Window and the Photo/Data Display Window, the cursor will 
change to two lines with two arrows above and below the lines.  If the 

user holds the left mouse button down, the user can size 
the Photo/Data Display Window to better fit 

the photos and data being displayed. 
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Three buttons control the display of the photos and data.  These are the Data, 
Graph and View buttons.  
 
The Data Button 
If the Data button is clicked, the data summary for that photo is displayed in  
the right pane of the Photo/Data Display Window. The following screen 
shows the Data button selected for both sides of the Photo/Data Display 
Window. 
 

 
 
The Graph Button 
If the Graph Button is clicked, a pie chart showing the fuel loading data for the selected photo is 
shown in the right pane of the Photo/Data Display Window. The following screen shows the 
Graph button selected for both sides of the Photo/Data Display Window. 
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The View Button 
If the View button is clicked, a full screen view of the photo will be shown.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Viewing of the data plate associated with the Photo Series 
photo is also possible.  To view that data plate, click on the 
Data Plate Tab. 
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When viewing a photo or a data plate, the user can view the 
image at its actual size based on the resolution it was scanned 
to.  The user can also view an image in a size that fits the 
display window. 
 
Compare Photo Series Mode 
By selecting the Compare Photo Series Mode, two photos can be displayed simultaneously in the 
Photo/Data Display Window.   

To enable the Compare Photo Series Mode, click on the  icon on the Toolbar or select 
Tools=>Compare Photo Series from the main menu. 
 

Hot Tip 

 

To select a photo to be displayed on one side of the Photo/Data Display 
Window, select that side as the “active” side by either clicking on 

the arrow above the buttons in the center of the Photo/Data  
Display Window or click anywhere within the area  

occupied by the photo. 

 
The screen that follows shows two photos displayed simultaneously.   
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Four buttons control the display of the photos and data.  These are the 
Image, Data, Graph and View buttons.  
 
Image Button 
The photo that has a yellow bar at the top of the photo display window 
is the active photo. To designate a photo to be the active photo, do a left 
mouse click in the center of the photo. 
 
The Data Button 
If the Data button is selected, the data summary for that photo is displayed on the same side of 
the Photo/Data Display Window as the button selected. 
 
The Graph Button 
If the Graph Button is clicked, a pie chart listing the fuel loading data for the selected photo is 
shown in the Photo/Data Display Window.  
 
The View Button 
If the View button is selected, a full screen view of the active photo will be shown. 
 
PSExplorer Assistant, Comparison Assistant Tab 
The PSExplorer Assistant appears automatically upon selection of the Photo Series Compare 
Mode.  

The Assistant will also appear on the screen by clicking on the  icon. 
 
The Comparison Assistant Tab displays 
fuel loading, duff depth and fuel bed depth 
information for each photo.  The cell with 
the red text has the highest value for the 
information displayed for the two photos.  
The Difference column displays the 
difference in the data between the two 
photos.  
 
 
 
 

Hot Tip 

 

 
Clicking the Hide button will cause the Assistant to close.   

 
The Assistant can be display again by clicking on the Assistant  

icon or by selecting the View => Assistants menu. 
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Fuel Profile Builder Mode 
By selecting the Fuel Profile Builder Mode, the user can build a fuels profile defined by 
assigning a Photo Series photo to each of the following profile characteristics: 
 

 0”-3.0” Fuel Loading 
 3.1”+ Fuel Loading 
 Herb Loading 
 Shrub Loading 
 Duff Depth 
 Fuel Bed Depth 

 

To enable the Profile Builder Mode, click on the  icon on the Toolbar or select Tools => 
Fuel Profile Builder from the main menu. 
 
PSExplorer Assistant, Profile Builder Assistant Tab 
The PSExplorer Assistant appears automatically upon selection of the Profile Builder Mode. 
 

The Assistant will also appear on the screen by clicking on the  icon. 
 
When the user selects the Profile Builder 
Mode, the PSExplorer Assistant appears 
with the Profile Builder Assistant tab 
active.  By clicking on the Add button, the 
loading or depth is assigned from the 
active photo.  Clicking on the Display 
Photo button will cause the assigned 
photo to be displayed in the Photo/Data 
Display Window.  Note that if the selected 
data attribute for the active photo is N/A 
(Not Available), then a 0.0 is entered for 
that attribute in the fuel profile. 
 
The Notes Button  
The user can click on the Notes button to activate a dialog box that allows the user to enter 
information about the fuel profile defined.  The information in the Notes box is printed on the 
Fuel Profile Report. 
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The Save Profile As Button  
Profiles can be saved.  To save a profile, 
click on the Save Profile As button and 
assign a profile name like Guide.  Do 
not assign an extension as PSExplorer 
will automatically assign a .pr3 
extension.  In the screen at the right, the 
new fuels profile is being assigned a file 
name of Guide.pro and note that there is 
currently a PSE_Example.pr3 fuel 
profile saved. 
 
The Save Profile Button  
Selecting this button saves the profile 
using the current profile file name. 
 
The Load Profile Button  
Selecting this button allows the user to select a previously saved fuel profile. 
 
The New Profile Button  
Selecting this button clears the Fuel Profile Builder Assistant screen of assignments. 
  
The Reports Main Menu 
This main menu item allows the user to print reports based on the 
mode selected within PSExplorer. 
 
 
The Help Menu 
This main menu item allows the user to access the Help system, Internet 
Web Based Support and the About screen. 
 
Help Contents 
The PSExplorer program has a fully developed Help system.  Use this 
menu item to activate the on-line Help system.   Questions that cannot be resolved via the on-line 
support system should be addressed by contacting technical support. 
 
Web Based Support 
If the user has an active connection to the Internet, selecting this menu item will open the default 
Internet browser on the computer and direct the user to the FMAPlus Support Page.  From this 
page, you can obtain information on program features and program updates as well as make 
contact to FMAPlus Support System.   
 
About 
This menu item will produce a screen showing the Version number of PSExplorer you are 
running as well as a copyright protection notice.  The System icon can be activated to show the 
status of the user’s system resources. 
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The Query Tabs 
If the Screen mode is set to Query, then the Query Tabs appear.  These tabs allow the user to 
select the type of query desired.   
 

Hot Tip 

 

Only photos that are in the universe of active photos prior to a search 
will be included in the photos selected from a search. 

 
To reset the universe of active photos to include all photo from all active photo series, click on 
the Display all Photos icon or select the View => Display All Photos menu. 
 
There are five query modes: 
 

 Query by Photo Series Book 
 
 Query for Total Dead Down Woody Fuel Loading Using Vegetation Type, Activity Type 

and Dead Down Woody Total Fuel Loading 
 

 Query for Total Dead Down Woody Fuel Loading Using Vegetation Type, Activity 
Type, 0-3” and 3.1”+ Dead Down Fuel Loading 

 
 Query for Live Fuel Loading Using Vegetation Type, Activity Type, Herbaceous and 

Shrub Fuel Loading 
 

 Query by 1982 Fire Behavior (FBPS) or Danger Rating (NFDRS) Fuel Model 
 
Query by Book Tab 
This query mode allows the user to search by Photo Series Book.  Only one Book can be selected 
at a time. 
 

 
 
Query by DDW Total Loading Tab 
This query mode allows the user to search the universe of active photos by Vegetation Type, 
Activity Type and Total Dead Down Woody Fuel Loading. 
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Query by DDW 0-3” and 3.1”+ Loading Tab 
This query mode allows the user to search the universe of active photos by Vegetation Type, 
Activity Type, 0”-3” Fuel Loading and 3”+ Fuel Loading. 
 

 
 
Query by Live Loading Tab 
Query the universe of active photos for Live Fuel Loading Using Vegetation Type, Activity 
Type, Herbaceous and Shrub Fuel Loading 
 

 
 
Query by Fuel Models Tab 
This query mode allows the user to search the universe of photos by Danger Rating (NFDRS) or 
1982 Fire Behavior (FBPS) Fuel Models. When doing a Query by Fuel Model, select fuel 
models solely from the Danger Rating Fuel Models or the 1982 Fire Behavior Fuel Models. 
 

 
 
On each query tab, query selection criteria are defined using pulldowns for one more many query 
criteria. Each tab has a Search button and an Erase Displayed Photo(s) check box. 
 
The Search Button 
Based on search criteria, this button is used to activate the search for photos. 
 
The Erase Displayed Photo(s) Check Box 
If this box is checked, then the photo displayed in the Photo/Display Window will be replaced 
with the first photo listed in the Selected Photo Series Browse Window.  If this box is not 
checked, the photo in the Photo/Display Window will change only by the selection of a photo 
from the Selected Photo Series Browse Window.   
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Searching for Photos 
Date base queries allow photo series searches based on defined criteria.  Four types of queries 
are available: 
 

 Query by Photo Series Book 
 

 Query for Total Dead Down Woody Fuel Loading Using Vegetation Type, Activity Type 
and Dead Down Woody Total Fuel Loading 

 
 Query for Total Dead Down Woody Fuel Loading Using Vegetation Type, Activity 

Type, 0-3” and 3.1”+ Dead Down Fuel Loading 
 

 Query for Live Fuel Loading Using Vegetation Type, Activity Type, Herbaceous and 
Shrub Fuel Loading 

 
 Query by 1982 Fire Behavior (FBPS) or Danger Rating (NFDRS) Fuel Model 

 
Query by Photo Series Book 
This query mode allows the user to search by Photo Series Book.  Only one Book can be selected 
at a time.   
 

 
 
To Query by Photo Series Book, click on the pull-down arrow to the right side of the window 
that shows “All Books.”  Select a specific Photo Series.  Perform the search by clicking on the 
Search button.  Selecting “All Books” and clicking on the Search button will yield the same 
search result as clicking on the All Photos button. 
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Query for Total Dead Down Woody Fuel Loading Using Vegetation Type, 
Activity Type and Dead Down Woody Total Fuel Loading 
This query mode allows the user to search the universe of photos by Vegetation Type, Activity 
Type and Total Loading. 
 

 
 
To Query by Total Loading including the option to select Vegetation Types and Activity Types, 
select the desired item(s) by clicking on the pull-down arrow on the right side of the window.  
Select the desired selection criteria.  For Vegetation Types and Activity Types, more than one 
Vegetation Types and/or Activity Types can be selected.  The screen below shows three 
Vegetation Types selected.  To close the Vegetation Type selection pulldown, press the ESC 
button on the keyboard or click on the white area to the right of the pulldown area.  
 

 
 
The following screen shows the three Vegetation Types that contain Ponderosa pine selected, 
one Activity Type selected (Natural) and a Total Loading of 10 to 24 tons per acre selected for a 
Search.  By clicking on the Search button, the program will query the data base for the universe 
of photos available to display the photos that meet the query criteria. 
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Query for Total Dead Down Woody Fuel Loading Using Vegetation Type, 
Activity Type, 0-3” and 3.1”+ Dead Down Fuel Loading 
This query mode allows the user to search the universe of active photos by Vegetation Type, 
Activity Type, 0”-3” Dead Down Fuel Loading and 3.1”+ Dead Down Fuel Loading. 
 

 
 
To Query by 0”-3” Fuel Loading and 3.1”+ Fuel Loading including the option to select 
Vegetation Types and Activity Types, select the desired item(s) by clicking on the pull-down 
arrow on the right side of the window.  Note that for a photo to be selected, it must meet all four 
conditions. 
 
The following screen shows the three Vegetation Types that contain Ponderosa pine selected, the 
Natural Activity Type selected, 0.0”-3.0” loading of 4 to 10 tons per acre and a 3.1”+ loading of 
10 to 24 tons per acre selected.   
 

 
 
By clicking on the Search button, the program will query the universe of active photos and 
display the photos that meet the criteria. 
 
Query for Live Fuel Loading Using Vegetation Type, Activity Type, 
Herbaceous and Shrub Fuel Loading 
This query mode allows the user to search the universe of active photos by Vegetation Type, 
Activity Type, Herbaceous Loading and Shrub Loading. 
 

 
 
To Query by Herbaceous Loading and Shrub Loading including the option to select Vegetation 
Types and Activity Types, select the desired item(s) by clicking on the pull-down arrow on the 
right side of the window.  Note that for a photo to be selected, it must meet all four conditions. 
 
By clicking on the Search button, the program will query the universe of active photos and 
display the photos that meet the criteria. 
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Query by Fire Behavior (FBPS) or Danger Rating (NFDRS) Fuel Model 
This query mode allows the user to search the universe of active photos by Danger Rating 
(NFDRS) or Fire Behavior (FBPS) Fuel Models.   
 

 
 
There are correlations between fuel models within these two systems.  For example, NFDRS 
Fuel Model G is similar to FBPS Fuel Model 10. A query with NFDRS Fuel Model G selected in 
the Danger Rating window and FBPS Fuel Model 10 selected in the Fire Behavior window 
would yield the same set of resultant photos from a search with just one of the two fuel models 
selected.  Conversely, selecting a NFDRS fuel model and a FBPS fuel model in each window, 
which are not equivalent, will result in no photos being selected in the search query.   
 
 

Hot Tip 

 

 
When doing a query by fuel model, select fuel models solely from the 

Danger Rating Fuel Models or the Fire Behavior Fuel Models. 
 

 
Below is a screen with 1 Danger Rating Fuel Model selected.  By clicking on the Search button, 
the program will query the universe of active photos and display the photos that meet the query 
criteria. 
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Using Local Photo Series 
Via use of the Photo Manager program, the user can enter photo series attribute data in the 
photos database (photo3.mdb) in FMAPlus 3.   If the user also creates electronic graphic files of 
each photo and photo data place, the user can then use the local photo series in the same manner 
as the published photo series that come with FMAPlus. 
 
Photo Series Attributes 
For each photo in a local photo series, the following attributes need to be defined.  If an attribute 
cannot be defined, a special entry will be made to signify that to the programs in FMAPlus. 
 

 Book/Photo ID 
 Photo Description 
 0.0” – 3.0” Dead Down Woody (DDW) Fuel Loading (Tons/Acre) 
 3.1”+ Dead Down Woody (DDW) Fuel Loading (Tons/Acre) 
 Total Dead Down Woody (DDW) Fuel Loading (Tons/Acre) 
 Herbaceous Fuel Loading (Tons/Acre) 
 Shrub Fuel Loading (Tons/Acre) 
 Duff Depth (inches) 
 Fuel Bed Depth (inches) 
 Vegetation Type 
 Activity Type 
 FBPS (FB) Fuel Model 
 NFDRS (DR) Fuel Model 
 Photo Graphic File Name 
 Data Plate Graphic File Name 

 
The user will enter the photo series attributes using the Photo Manager Program.  An example of 
a completed set of attributes is shown below.  Details on the process will follow in subsequent 
sections. 
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Electronic Graphics Files for Photos and Data Plates 
Photos from locally developed photo series can be scanned and 
saved in either JPG or GIF file format.  Place these graphic files 
in a folder inside the PhotoImages folder.  For example, if a 
local photo series was created with a title of 1Tieton, the folder 
for the electronic photo and data plate images would be in the 
1Tieton folder inside the PhotoImages folder.  See the figure at 
the right.  
 
Graphic File Resolution 
It is recommended that images be scanned and saved to a 
resolution of about 1 megapixel or 640x480.  Scanning images 
to a high resolution will not improved their viewing resolution. 
 
Photo and Data Plate Files 
Following are some recommendations on the naming convention to use for the electronic 
graphics files.   
 
Start the file name for each photo image file with a “p” and start the name for a data plate image 
file with a “d”. 
 
The file name of the photo and data plate files should have a tie to the photo name in the paper 
version of the photo series.  For example, a photo in GTR-PNW-105 has the title of 2-DFHD-2 
in the paper version of the photo series.  A suggested name for the photo image file is 
p2dfhd2.xxx and for the data plate image file is d2dfhd2.xxx where xxx is either jpg or gif. 
 
Once the photo image and data plate graphic image have been created by scanning, and have 
been appropriately named, copy the graphics file into the local photo images folder created 
earlier in the PhotoImages folder.  
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Using Photo Manager to Enter Local Photo Series Attributes into the Photos 
Database 
Start the Photo Manager program using the Start => Programs => FMAPlus 3 => Photo 
Manager.  The screen below will appear. 

 
Creating a Photo Series Book 
To create a photo series book, click on the Create a Book button.  The screen below will appear. 
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The Book Information Area 
The first task is to complete the Book Information section of the books creation screen.  The 
Books Information area of the books creation screen will appear as shown below when initially 
opened. 
 

 
 
An example for this Users’ Guide has been created and is distributed with the FMAPlus 3.  The 
photo series name is Custom-PS.  A folder called Custom-PS has been created in the 
PhotoImages folder. Ten images have been copied into that folder, five are photos and five are 
data plates.  The process that was followed to create this example will be described. 
 
The data for the example that be entered in the Book Information screen is as follows: 
 

 Identifier: Custom-PS 
 Name: Custom Photo Series Example 
 Built By: FMAPlus User 
 Built Date: 02/20/2005 
 Data Entry Aids: “Use Automatic Photo and Data Plate Naming 
 File Type: JPEG (jpg) 
 Size Classes: 3.1” – 9.0”, 9.1 – 20.0” and 21.1”+. 

 
The completed Books Information section for the Custom-PS photo series is shown below. 
 

 
 
Entering and Editing Cell Characters in the Books Information Area 
When the Photo Manager – Create/Edit Book screen first appears, the cursor is in the Identifier 
cell.  Pressing the Tab key will move the cursor progressively to additional cells.  The user can 
use the mouse to perform a left mouse click in a cell to move the cursor to that cell.  To edit cell 
characters, place the cursor in the cell and make the desired edits. 
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Identifier Field 
This is the folder name in the PhotoImages folder.  It is recommended to keep this name short.  
Note that the name can contain only acceptable characters based on the Windows file naming 
standards.  
 
Name 
This is a descriptive name for the photo series. 
 
Built By 
This field identifies who built the photo series. 
 
Built Date 
This field documents the date the photo series book was built in FMAPlus. 
 
Data Entry Aids  
There are three check boxes in this area as well as a (Graphics) File Type definition window. 
 
Add New Photo with Previous Photo Name 
When the item is checked, the Photo Name 
from the last photo in the entry will be entered 
as the photo name for a newly Added Photo.  
A new data row for entering attributes for a 
new photo is accomplished using the Add 
Photo button. This feature may allow the user 
do less data entry.  
 
No Images in this Book 
When this item is clicked, the data entry columns for the Photo File name and the Data Plate File 
name will disappear from the screen. 
 
Use Automatic Photo and Data Plate Naming and File Type 
When the item is checked, the file names for the photo and data plate files will be automatically 
created using a standard naming convention.  The standard naming convention in Photo Manager 
is PXXXXX.YYY for photo image files and DXXXXX.YYY for data plate image files.  The 
formats are the same except that the file name for photo graphic images starts with a P and for 
data plate graphic images starts with a D.  The XXXXX stands for user defined Photo ID and the 
YYY stand for the user selected File Type (JPEG or GIF).  In the example, the Photo ID is 
Custom1 and when the cursor is moved from the Photo ID cell, the files names shown in the 
lower right graphic will be created. 
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Size Classes 
The 3.1” dead down woody material is 
frequently subdivided into 3 to 4 
classes based on diameter of the 
material.  In the Size Class area, the 
user can define up to 4 size classes.  To define a size class, enter the value in inches for the upper 
size class break.  In the example shown, the first size class is 3.1” to 9.0,” size class section 4.  
Notice that in the size class section 5, the program automatically set the beginning of that size 
class to be 0.1” greater than the upper limit is size class section 4.  Continue entering values until 
complete.    
 
The Photos Area 
The photos area is where the attributes for each photo are entered.   
 

 
 
The photo that has the black right facing arrow in the first column is 
called the “active row.” 
 
 

Hot Tip 

 

 

The width of attribute fields can be changed to facilitate viewing. 
 

To change the width of a column, do a left mouse click on a column border 
and while continuing to hold the left mouse button down, drag the  

border to increase or decrease the column width. 
 

 
Adding and Deleting Photos 
To add a photo, click on the Add Photo button.  Note that the 
photo “row” added will be at the bottom of the existing photo 
“rows.”  To delete a photo, click on the row to make it the 
active photo and then click on the Delete Photo button. 
 
Adding a Duplicate Photo 
The user may wish to add a photo whose attributes are similar to the last photo 
in the photo series listing.  To save time on data entry, the user can add a photo 
with its attributes being identical to the last row in the photo series by clicking on the Duplicate 
Photo button.  In the figure below, a duplicate row has been added.  Notice the user still needs to 
enter a unique Photo ID. 
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Entering Cell Characters in the Photos Area 
When the Photo Manager – Create/Edit Book 
screen first appears, the cursor is in the 
Identifier cell.  The user can use the mouse to 
perform a left mouse click in a cell to move the 
cursor to that cell.  When the user starts to enter 
data into a cell, there will be a pencil icon in the 
left column of the photo row.  This indicates 
that data is being entered in cell rows.  However, the data entered is not written to the 
photo3.mdb until the cursor is moved to another cell that is not on the current photo row being 
edited.  The user can use the mouse to click in a cell on the current photo row being edited or can 
use the up or down arrow keys on the keyboard to perform this action.  When the cursor has been 
moved to a cell not on the current photo row being edited, the pencil will change to a solid black 
right facing arrow on the photo row where the cursor was moved.  When the user sees the solid 
black right facing arrow on a photo row, then the user knows the edits have been written to the 
photo3.mdb file. 
 
Editing Cell Characters in the Photos Area 
To edit cell characters, place the cursor in the cell and make the edits as desired.  To insure edits 
have been written to the photo3.mdb file, move the cursor to a cell that is not on the photo row 
where the edits occurred. 
 
The example photo series will appear as shown below once all information has been entered into 
the Books Information and Photos areas. 
 

 
 
Saving Edits to a Photo Series Book 
 To save entries on the Create/Edit Book screen, click on the 
Save and Close button.   Clicking the Cancel button with close 
the Create/Edit Book screen without saving edits. 
 
Making a Local Photo Series Active 
Once a the photo attributes have been entered and saved, the 
user can make the photo series available by clicking on the 
check box in the Active column to the left of the photo series 
identifier. 
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Copying Photo Images to the Photo Series Folder 
The last activity necessary for a custom photo series to be utilized by programs in FMAPlus is to 
copy the photo and data plate graphic image files to the photo series folder in the PhotoImages 
folder.  Use Windows Explorer to copy these files (see below left).  The file names need to be 
the same as those defined in the photo series books file (see below right). 
 

 
Editing a Photo Series Book 
The user can only edit user entered local photo 
series books.  On the Photo Manager screen, the 
owner of a photo series is shown in the Owner 
column.  The user cannot edit published photo 
series books, which are owned by FMAPlus but 
can edit any photo series not owned by 
FMAPlus. 
 
To edit a locally created photo series, click on 
the row with the local photo series name and 
then click on the Edit Photo Series button.  
Follow the steps described in the Creating a 
Photo series Book section above for procedures 
on how to edit and save a local photo series 
book. 



Users’ Guide to PSExplorer, Version 3 PSE - Page 35

References 
 
Albini, Frank A, and James K. Brown. 1978. Predicting Slash Depth For Fire Modeling. USDA 
For. Ser. Res. Paper INT-206.22 p. 
 
Bailey, G. R. 1969. An evaluation of the line-intersect method of assessing logging residue. Can. 
Dep. Fish. & For., For. Prod. Lab. Inf. Rep. VP-X-23, 41 p. 
 
Beaufait, William R., Michael A. Marsden, and Rodney A. Norum. 1974. Inventory of slash 
fuels using 3P sub-sampling. USDA For. Serv. Gen. Tech. Rep. INT-13, 17 p., illus. 
 
Blonski, Kenneth S. and John L. Schramel.  1981. Photo Series for Quantifying Natural Forest 
Residues: Southern Cascades and Northern Sierra Nevada.  USDA For. Serv. Gen. Tech. Rep. 
PSW-56, 145 p. 
 
Brown, J. K. 1966. Forest floor fuels in red and jack pine stands. USDA For. Serv. Res. Note 
NC-9, 3 p. 
 
Brown, James K. 1971. A planar intersect method for sampling fuel volume and surface area. 
For. Sci. 17(l):96-102, illus. 
 
Brown, James K. 1972. Field test of a rate-of-fire-spread model in slash fuels. USDA For. Serv. 
Res. Pap. INT-116, 24 p., illus. 
 
Brown, James K., and Peter J. Roussopoulos. Eliminating biases in the planar intersect method 
for sampling small fuel volumes. For. Sci. (In press.) 
 
Deeming, John E., James W. Lancaster, Michael A. Fosberg, R. William Furman, and Mark J. 
Schroeder. 1972. National fire-danger rating system. USDA For. Serv. Res. Pap. RM-84, 165 p. 
 
Fahnestock, G. R. 1960. Logging slash flammability. USDA For. Serv. Res. Pap. TNT-58, 67 p., 
illus. 
 
Fischer, William C. 1981. Photo Guide for Appraising Downed Woody Fuels in Montana 
Forests: Grand Fir/Larch/Douglas-fir, Western Hemlock, Western Hemlock/Western Redcedar 
and Western Redcedar Cover Types. . USDA For. Serv. Gen. Tech. Rep. INT-96, 53 p. 
  
Fischer, William C. 1981. Photo Guide for Appraising Downed Woody Fuels in Montana 
Forests: Interior Ponderosa Pine. Ponderosa Pine/Larch/Douglas-fir, Larch/Douglas-fir and 
Interior Douglas-fir Cover Types. . USDA For. Serv. Gen. Tech. Rep. INT-97, 133 p. 
 
Fischer, William C. 1981. Photo Guide for Appraising Downed Woody Fuels in Montana 
Forests: Lodgepole Pine and Englemann Spruce-Subalpine Fir Cover Types. . USDA For. Serv. 
Gen. Tech. Rep. INT-98, 143 p. 
 
 



Users’ Guide to PSExplorer, Version 3 PSE - Page 36

Fosberg, Michael A. 1970. Drying rates of heartwood below fiber saturation. For. Sci. 16(l): 57-
63, illus. 
 
Howard, James O., and Franklin R. Ward. 1972. Measurement of logging residue--alternative 
applications of the line intersect method. USDA For. Serv. Res. Note PNW-183, 8 p. 
 
Hutchings, S. S., and J. E. Schmautz. 1969. A field test of the relative-weight-estimate method 
for determining herbage production. J. Range Manage. 22:408-411. 
 
Koski, Wayne H. and William C. Fischer. 1979. Photo Series for Appraising Thinning Slash in 
Northern Idaho; Western Hemlock, Grand Fir and Western Redcedar Timber Types. USDA For. 
Serv. Gen. Tech. Rep. INT-46, 50 p. 
 
Lynch, Christine M. and L.J. Horton. 1983. Photo Series for Quantifying Forest Residues in: 
Loblolly Pine, Eastern White Pine, Pitch Pine and Virginia Pine. USDA For. Serv. and Penn. 
Env. Res.- Bur. Of For. NA-FR-25. 69 p. 
 
Maxwell, Wayne G. and Franklin R. Ward. 1976.  Photo Series for Quantifying Forest Residues 
in the: Coastal Douglas-fir-Hemlock and Coastal Douglas-fir Hardwood Types. USDA For. 
Serv. Gen. Tech. Rep. PNW-51, 103 p. 
 
Maxwell, Wayne G. and Franklin R. Ward. 1976.  Photo Series for Quantifying Forest Residues 
in the: Ponderosa Pine, Ponderosa Pine and Associated Species and Lodgepole Pine Types. 
USDA For. Serv. Gen. Tech. Rep. PNW-52, 73 p. 
 
Maxwell, Wayne G. and Franklin R. Ward. 1979. Photo Series For Quantifying Forest Residues 
in Sierra Mixed Conifer and Sierra True Fir Types. USDA For. Serv. Gen. Tech. Rep. PNW-95, 
79 p. 
 
Maxwell, Wayne G. and Franklin R. Ward. 1980.  Photo Series for Quantifying Natural Forest 
Residues in Common Vegetation Types of the Pacific Northwest.  USDA For. Serv. Gen. Tech. 
Rep. PNW-105, 229 p. 
 
Ottmar, Roger D. and Robert E. Vihnanek. 1998. Stereo Photo Series for Quantifying Natural 
Fuels.  Volume I: Mixed-conifer with Mortality, Western Juniper, Sagebrush and Grassland 
Types in the Interior Northwest. PMS 830. Boise, ID: National Wildfire Coordinating Group, 
National Interagency Fire Center. 65 p. 
 
Ottmar, Roger D. and Robert E. Vihnanek. 1998. Stereo Photo Series for Quantifying Natural 
Fuels.  Volume II: Black Spruce and White Spruce Types in Alaska. PMS 831. Boise, ID: 
National Wildfire Coordinating Group, National Interagency Fire Center. 65 p. 
 
Ottmar, Roger D. and Robert E. Vihnanek. 1998. Stereo Photo Series for Quantifying Natural 
Fuels.  Volume III: Lodgepole Pine, Quaking Aspen and Gambel Oak Types in the Rocky 
Mountains. PMS 832. Boise, ID: National Wildfire Coordinating Group, National Interagency 
Fire Center. 65 p. 



Users’ Guide to PSExplorer, Version 3 PSE - Page 37

 
Ottmar, Roger D. and Robert E. Vihnanek. 1999. Stereo Photo Series for Quantifying Natural 
Fuels.  Volume V: Midwest Red and White Pine, Northern Tallgrass Prairie and Mixed Oak 
Types in the Central and Lake States. PMS 834. Boise, ID: National Wildfire Coordinating 
Group, National Interagency Fire Center. 99 p. 
 
Ottmar, Roger D., Robert E. Vihnanek and Jon C. Regelbrugge. 2000. Stereo Photo Series for 
Quantifying Natural Fuels.  Volume IV: Pinyon-Juniper, Chaparral and Sagebrush Types in the 
Southwestern United States. PMS 833. Boise, ID: National Wildfire Coordinating Group, 
National Interagency Fire Center. 97 p. 
 
Ottmar, Roger D. and Robert E. Vihnanek. 2000. Stereo Photo Series for Quantifying Natural 
Fuels.  Volume VI: Longleaf Pine, Pocosin and Marshgrass Types in the Southeastern United 
States. PMS 835. Boise, ID: National Wildfire Coordinating Group, National Interagency Fire 
Center. 56 p. 
 
Ottmar, Roger D. and Robert E. Vihnanek. 2002. Stereo Photo Series for Quantifying Natural 
Fuels.  Volume IIa: Hardwoods with Spruce in Alaska. PMS 836. Boise, ID: National Wildfire 
Coordinating Group, National Interagency Fire Center. 41 p. 
 
Ottmar, Roger D., Robert E. Vihnanek and Clinton S. Wright. 2002. Stereo Photo Series for 
Quantifying Natural Fuels.  Volume Va: Jack Pine in the Lake States. PMS 837. Boise, ID: 
National Wildfire Coordinating Group, National Interagency Fire Center. 49 p. 
 
Ottmar, Roger D.; Vihnanek, Robert E.; Mathey, Jared W. 2003. Stereo Photo Series for 
Quantifying Natural Fuels. Volume VIa: Sand Hill, Sand Pine Scrub, and Hardwoods with White 
Pine Types in the Southeast United States with Supplemental Sites for Volume VI. PMS 838. 
Boise, ID: National Wildfire Coordinating Group, National Interagency Fire Center. 78 p. 
 
Roussopoulos, P. J., and V. J. Johnson. 1973. Estimating slash fuel loading for several Lake 
States tree species. USDA For. Serv. Res. Pap. NC-88, 8 p. 
 
Rothermel, R. C. 1972. A mathematical model for predicting fire spread in wildland fuels. 
USDA For. Serv. Res. Pap. INT-115, 40 p., illus. 
 
USDA Forest Service. 1955. Wood Handbook No. 72, 528 p. For. Prod. Lab., Madison, Wis. 
 
USDA Forest Service. 1959. Techniques and methods of measuring understory vegetation. 
Southern and Southeast For. Exp. Stn. Symp. Proc., 174 p. 
 
USDA Forest Service.  Photo Series for Quantifying Forest Residues in the Southwestern 
Region: Black Hills Photo Series A-89-6-82. USDA Southwestern Region.  Regional Office.  
Albuquerque, NM.  Pages 10- 89. 
 
Van Wagner,C. E. 1968. The line intersect method in forest fuel sampling. For. Sci. 14(l): 20-26, 
illus. 



Users’ Guide to PSExplorer, Version 3 PSE - Page 38

 
Wilcox, Fredrick, John McCarty and Barry Bungard. 1982. Photo Series for Quantifying Forest 
Residues in the: Northern Hardwood and Oak-Hickory Types.  USDA For. Serv. and Penn. Env. 
Res.- Bur. Of For. NA-FR-22. 43 p. 
 
 


